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Collect Three Sparkling Learning
Adventures in Treasureland!

There is a place called Treasureland. It is a magical place
filled with gold, treasures, colorful sea creatures, and friendly
elves. All was well until Morty Maxwell, the Master of
Mischief, began to make trouble . . . that’s when the Super
Seekers were called in!

The Master of Mischief stole the magic crown, hid the elves’
treasures, and is hoarding all the mountain’s gold! In
the classic adventure Treasure Mountain!, you, the
Super Seeker, help the elves by finding the

4

treasures and winning back the crown. ;'.5‘
. . o -~
Use a combination of reading, ~/
math, science, and /
thinking skills
# ~

to answer the
elves’ puzzlers and
win clues that lead you
to the hidden
treasures. You’ll
send the Master
of Mischief
packing!

ks
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BRRRR! The temperature drops when the Master of Mischief’s
weather machine covers Treasureland in snow and ice! His
winter storm has wreaked havoc on the mountain kingdom,
scattering the treasures and freezing the magic crown. Turn up
the heat on the Master of Mischief in Treasure MathStorm! by
using your real-life math skills to reset Treasureland’s clocks,




balance its gold scales, and count its crystals. You’ll build
math, time-telling, and money-counting skills as you find the
treasures, unfreeze the magic crown, and restore order to
Treasure Mountain!

The mischief flows underwater in Treasure Cove!, where the
Master of Mischief’s experiments are polluting the ocean! To
prevent you from reaching him in his laboratory, the Master of
Mischief has destroyed Rainbow Bridge between Treasure
Mountain and Invention Island. Now the bridge’s shining
gems lie hidden at the bottom of Treasure Cove! Use your
science, deductive thinking, math, and reading skills to stop the
mischief! You’ll learn about sea creatures and save the ocean
from the gooey goobies by finding

the gems and rebuilding
Rainbow Bridge in this
colorful search for
sunken treasure!
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Getting
Started

ELCOME, SUPER SEEKER, TO THE
START OF A GREAT ADVENTURE! This chapter
tells you how to load the Treasure Mountain! pro-
gram and sign in as a Super Seekers Club member.
You'’ll also find out how to use the game screen and
the menu bar. Are you ready? Thenreadon. . .




1 GETTING STARTED

STARTING THE PROGRAM

Before you start the program for the first time, it’s best
to make a backup copy of the program disk(s). For
instructions on how to make a backup copy of a disk
using the DOS (Disk Operating System) command
DISKCOPY, see your DOS manual.

The most efficient way to run the program is to install
(copy) it on your hard disk, if you have one. Read
Appendix A: Hard Disk Installation in this user’s guide
for complete instructions. If you don’t have a hard
disk, you can run the program from a floppy disk.

If you’re using Tandy® DeskMate™ , read the procedures
in Appendix B: Tandy DeskMate Installation. If you’'re
using Microsoft® Windows™, read the procedures in
Appendix C: Microsoft Windows Installation.

Running Treasure Mountain!
from a Floppy Disk

1. Put your DOS disk (version 2.0 or higher required)
in drive A of your computer. Close the disk drive
door or latch. (If DOS is in your computer’s perma-
nent memory or on a hard disk, or if your computer
is already up and running, you don’t have to insert
the DOS disk.)

2. Turn on your monitor, and then your computer.
Wait a few moments while your computer starts up.




Running Treasure Mountain!

3. Watch your monitor screen. If you see the mes-

sages for entering a date and time, press

on your keyboard twice.

4. When you see A> on your screen, remove the DOS
disk. Then put the program disk (Disk 1 if you’re
using 5.25" disks) in drive A, and close the door or
latch. (Note: If you have two 5.25" disk drives, put
Disk 1 in drive A and Disk 2 in drive B.)

If you see C> on your screen, put the program disk
in drive A and close the door or latch. Then type A:

and press .
5. To start the game, type TMT and press :

In a few moments, the Treasure Mountain! title
screen appears.

6. Press to continue. Read the story
screens about the game. Keep pressing

until you see the Club Sign-In screen. This is the
screen where you add your name as a member of
the Super Seekers Club.




1 GETTING STARTED

SIGNING IN

Only genuine members of the
Super Seekers Club have what it
‘| takes to chase down the Master

| of Mischief. You can join now,
| at the Club Sign-In screen. This
screen lists all the current club
members, their ranks, and their
total treasures collected.

New Players

1. New Player is highlighted on the Club Sign-In
screen. (If itisn’t, press (1] or [T] to highlight it.)
Now press .

Enter New Player Name 2 Type your name — up to 8
i characters — on the screen that

the box below.

e T appears. To erase a mistake,
(ool ] press (Backspace]. Then
=0 _to Go Back type again.

3. When you're finished, press . The game

begins!




Signing In

If You Need to Remove a Name

When the Club Sign-In screen has 9 names, it’s full.
You’ll need to remove a name so you can sign in as a
new club member. Here’s how:

1. Highlight New Player and press :

2. You are asked to remove a name so you can add

yours. Press to continue.

3. At the Remove Player Name screen, press | . |or
to highlight the name you want to remove. Then

press [ Ener.

4. A message warns you that the selected name and
score are about to be permanently erased. If you
still want to remove the name, press to high-

light Yes, then press . (Once a name and

score are erased, you can't get them back.)
5. Now follow the steps in the previous section, New

Players, to finish signing in.

When You’ve Played Before

If you’ve played Treasure Mountain! before, then
your name, rank, and score will already be on the list.

Press or to highlight your name, and then
press J Enter].




1 GETTING STARTED

GAME SCREEN INFORMATION

New
Menu Player Play

Bar \ Hint\ A}'ea

Flutter.

Hi' My name is

As your guide, I will give you

When the game begins, you’re
inside the Super Seekers club-
house on Treasure Mountain.

i If you like, you can explore the
| clubhouse. But the real action

New Player Hints to help you
learn to play the game.

| starts when you go out onto the

| mountain path. You may bump
into mischievous elves right

| away, so it’s best to be ready.
Read on to find out what’s on the
game screen to help you play.

Clue
Words Special

Instructions

New Player Hints

As soon as you begin playing, your guide, Flutter the
Butterfly, gives you your first New Player Hint. These
hints are tips about how to play the game. You'll see
them from time to time while you are a Trainee.

After you advance from Trainee to a 1-star Super
Seeker, the New Player Hints are automatically turned
off. If you want to turn them back on (or turn them
off from the start), use the Options menu (press )
described in this chapter.




Using the Menu Bar

Using the Menu Bar

The menu bar at the top left of the screen has 3 choices:
Help, File, and Options. Each item has its own menu, or
list. From there, you can find out more about playing
Treasure Mountain!, begin a game over or start a new
player, turn some game features on and off, and leave

(exit) the program.

SELECTING A MENU ITEM

1. Press the function key, (F1J, [F2], or [F3], for the

menu you want to see. The menu appears, showing

its list of items.

2. Press (1] or [T] to highlight the item you want.

Then press :

3. An information screen appears. Read the informa-

tion, then press to go on.

Note: You can also use the mouse to select menu items.
For information, read Selecting Menus and Items with

the Mouse later in this chapter.

HELP

Select Help (press ) to learn Help F1

about how to play the game. Select
the topic you want to read about.

Press to read the next

About the Game
Using the Keyboard
Using the Mouse
Getting More Hints

page. To return to a previous page,

[Esc] to Go Back

press to highlight Go Back a Page, and then press

. When you select Done, you’ll go back to
the Help menu. Or press to go back to the game.

7




1 GETTING STARTED

FILE

File F2

Start New Player
Exit and Save

[Esc] to Go Back

OPTIONS

New Player Hints

Sound

[Esd to Go Back

Select File (press ) to restart the game, start a new
player, or exit the program. Select the item you want,

read the message box, and then select
Yes or No. Your current rank and
score are saved when you Start New
Player or Exit and Save. When you
Start Over, any points (score) you’ve

accumulated in the current game will not be saved.

Select Options (press (F3)) to turn your New Player
Hints, game Music, and full game Sound off or on.

The New Player Hints are messages
from your guide, Flutter the Butter-
fly. They appear at the Trainee rank
to help you learn how to play. If you
want to see them at higher ranks, you

can turn them on again. You can also turn them off at
the Trainee rank, if you like.

If you turn the Music off, you'll still hear the game’s
special sound effects, which can help you as you play.

If you turn the Sound off, all the program’s sounds, in-
cluding music, will be off. With the sound off, you
play a game that’s completely quiet.

When you save a game, your Music and Sound settings
are also saved, along with your name, rank, and score.




Special Instructions

SELECTING MENUS AND ITEMS
WITH THE MOUSE

If you like, you can use your mouse to see menus and
select items from them. Point to the menu or menu
item you want, and click the mouse button. Do the
same to select answers or phrases at the bottom of
message screens.

Special Instructions

The special instructions box (at the bottom center of
your screen) tells you how to continue, or what actions
you can take next. For example, when a message is
showing on screen, this box will tell you to “Press

to go on.” When you’re in an area where
you can drop a coin, the instruction will be “Press
to drop coin.”

Status Box

The status box (at the bottom right) keeps count of all
the things you carry. As you play, you’ll earn, use, and
lose coins. Look at the number be-
low the coin sack to check your coin

supply.

Coin:  Net Treasure

A F &

Your net is a bit fragile. Each time
you catch an elf, the net wears out a [[ECEEEES L 0
little. When it wears through, the

elves can hop right out! Look at the
number to see how many more times
you can catch elves before your net needs repair.

Coins Treasure
Net




1 GETTING STARTED

Each treasure you find as you hike the mountain goes
into your treasure pack. Watch the treasure diamonds
next to your treasure pack. Altogether, they show how
many treasures are on that level of the mountain. Each
time you find a treasure, one of the diamonds fills in.
When all the diamonds are filled, you've found all the
treasures on that mountain level. The number below
the treasure pack shows the total treasures you’ve col-
lected so far in the current game.

Clue Words

Clue words help you find treasures and locate the keys
you need to open locks. When you earn a clue word
from an elf, it shows up in the Clue Words box (at the
bottom left of the screen). When you find the key, the
outline of a key in the Clue Words box fills in.

Note: For instructions on using your clue words, read
Treasure Hunting in the next chapter.




The Play Area

THE PLAY AREA

The action happens in the play
area of your screen. As you play
through the game, you’ll explore
the mountain paths, catch elves,
solve puzzlers, earn coins, and
hunt for keys and treasures.

Now it’s time to start your search for the treasures!
Press or to move in front of the clubhouse
door. Then press to step smartly out onto the
mountain path. And away you go!

11







2

Playing
the Game

OMETHING STRANGE IS HAPPENING
ON TREASURE MOUNTAIN! The mountain’s gold
is disappearing! It must be the tricky Master of
Mischief, up to no good! He’s already stolen the
crown, and he’s hidden the elves’ treasures all over
the mountain.

Now you, Super Seeker, must find the treasures and
put a stop to the Master of Mischief’s nonsense. But
it won’t be easy! Climbing Treasure Mountain is
tricky. As you search for treasures, watch out for
gaps in the path where you can fall through. And
when you find the key to Fish Fountain, get ready
for a sopping wet ride! Now it’s time to get started —
and the sooner, the better!

13




2 PLAYING THE GAME

SEARCH THE MOUNTAIN

The Super Seekers have a clubhouse here on Treasure
Mountain. This is where you’ll start. You can come
back here from time to time, to see your prizes and
check your rank.

Before you start, here are some important instructions:

Rule 1: Read Carefully!

The ways up to the higher levels of Treasure Mountain
are locked. The keys are hidden on the mountain, and
the elves know where. They won't tell you, but if you
answer their questions correctly, they’ll give you clue
words to help you find the hiding places. You can get
3 clue words on each level. The key you're looking for
will be behind the object that matches all 3 clue words.
Watch out, though. Some of the questions are tricky.
That’s why they’re called “puzzlers.” For help, use
club rule number 1: Read carefully!

Rule 2: Don’t Leave Anything Behind!

The treasures are cleverly hidden, in places you might
not think to look. You can use your clue words to find
them — every hiding place matches 2 clue words. Keep
an eye on the status box, too. You need coins to find
the treasures and to repair your net. Finding all the
treasures on a path helps you earn points and win the
crown. So remember club rule number 2: Don’t leave
anything behind!




Search the Mountain

Rule 3: Stay Alert!

The frisky elves run all over the mountain — and are
they playful! They love sprinkling you with elf dust
and taking your coins. But if you’re clever, you can
keep out of their way, or catch them in your net. Then
they’ll give you coins and help you find the keys and
treasures. So keep an eye out for them by using club
rule number 3: Stay alert!

As you fill the treasure chest in the castle, you’ll earn
stars (increase your rank) on your way to becoming a
Champion Super Seeker! You’ll also earn prizes that
will entertain you.

The Game Plan on the next page will help you collect
treasures and win back the crown.

Ready? Then let’s go! You’ve got a mountain of
treasures to find!

15




2 PLAYING THE GAME

SEREET R

The Game Plan e

Catch elves in your net to get coins and see
puzzlers. Solve the puzzlers to earn clues to
where the treasures and keys are hidden.

Drop coins to uncover treasures. If you’re
near a hiding place, the treasure will flash
and magically jump into your treasure pack.
Treasures are hidden in places that match
any 2 of the 3 clue words on your level.

Drop coins to find the keys that open locks so
you can go up the mountain. Study your clue
words to discover a key’s exact hiding spot.
The key on each level is hidden in a place that
matches all 3 of your clue words.

Watch the status box to see if you’re running
out of coins or your net is wearing out. Catch
elves to earn more coins. And don’t wait too
long to get your net repaired at a net cave.

(If you have coins and nets left over at the end
of a game, you’ll take them with you when you
start your next game.)

Climb to the top of the mountain, bringing as
many treasures as possible, and unload them into
the treasure chest. You’ll need to make many
trips, and collect lots of treasures, in order to
win back the crown.




Moving Around the Mountain

MOVING AROUND
THE MOUNTAIN

You have a whole mountain to explore, with 3 trails
and the Secret Stone Tunnel. And you don’t want to go
sliding down the slippery mountainsides! Read on for
hints that can help you out.

Using Your Keyboard

To walk left or right, or to jump from ladder to
ladder in the Secret Stone Tunnel:

B Press or . Hold the key down to continue
in that direction.

To flip:

m Hold down (<] or (-], and then press [T].
(Or press or at the same time.)

You can somersault over elves, elf dust, and
broken parts of the path.

“When you see elf dust coming, flip away from it.
Listen for elf dust, too. If you can hear it coming,
you’ll have more time to get away!” — Maria,
2-Star Super Seeker

To drop a coin or climb down:

m Press [1].

17




2 PLAYING THE GAME

To drop your net:
m Press ;

To open locks, climb or ride up, enter caves and
tunnels, and walk up to an open net cave to repair
your net:

m Press [T].

Using Your Mouse

Flutter the Butterfly is your Treasure Mountain
.1 guide. If you’re using a mouse to move around
IL.: the mountain, Flutter is your mouse cursor.

Move your mouse to move Flutter, and click the
mouse button to make selections. When you move out
of the play area, Flutter changes to an arrow.

To walk left or right:

m Click on the left or right side of the path. Hold
down the mouse button to continue walking.

Drop coin.




Using Your Mouse

To flip left or right:

m When you’re standing still, click higher up on the
left or right side, above the path. When you’re
walking, move Flutter higher above the path.

To drop a coin:

m Click in the special instructions box.

To drop your net:

m When you’re standing still, click on the bottom
edge of the path. When you’re walking, move

Flutter lower on the path. Or press

at any time.

To open locks, climb or ride up or down, walk up to
an open net cave, and enter caves and tunnels:

m Move in front of where you want to go, place
Flutter there, and click the mouse button. To keep
going, hold down the button.

To jump from ladder to ladder in the Secret Stone
Tunnel:

m Click on where you want to go.

“| use the tunnels to get to the other side of the
. mountain. ltis faster, when | know for sure that
I want to be on the other side.” — Jeff, 3-Star
. Super Seeker

19




2 PLAYING THE GAME

CATCHING ELVES

Treasure Mountain is the home

' of many frisky, playful elves.

. They’ll help you if you can catch
. them. But some of them are

= g8l mischievous and like to play
SRl tricks on you!

Coins by the Sackful

On your first hike on the trail, you’ll see some of the
Treasure Mountain elves. As they skip along, you can
catch them in your net to earn coins. Look at the Coins
section of your status box at any time to see the exact
number of coins you have.

To catch an elf in your net:

m Turn toward the elf and press ;

Getting Clue Words

. Watch for the elves who carry
scrolls (rolled-up papers). The
8l scrolls have puzzlers on them.
. When you catch one of these
ol clves, you get to read the scroll
| and answer the question.




Getting Clue Words

“Did you know that a square is a special kind of
rectangle? It has four sides and four right angles
like a rectangle. What makes a square special?
All four sides are the same length!” — Flutter the
Butterfly

To answer a puzzler:
m Press or to move the box over the answer

you want. Then press [ Enter]. (Mouse users

can click on the answer.)

When you choose the right answer on your first try, you
get 2 gold coins. Even better, you also get a clue word.
Clue words help you find treasures and keys.

To put the clue word in the Clue Words box:
m Press again.

If you don’t get the answer right
the first time, try again! You get

3 chances to answer a puzzler You hase won > ciue wora
correctly. (But you have to catch sman

that elf again each time.) If you
get the answer right on your
second try, you get 1 coin. For a
right answer on your third try, you

don’t get any extra coins, but you still get a clue word.

21




2 PLAYING THE GAME

Dodging EIf Dust

As your rank increases, the elves get peskier. They’ll
often throw elf dust at you. When you hear the elf dust
coming, flip! You might be able to somersault over it.
If the elf dust touches you, you lose a coin. But if you
can catch an elf in your net, you get a coin back.

“| like to flip, especially over the elves and the elf
dust. But when | want to get somewhere in a
hurry, | always walk. | get there faster.” — Pat,
6-Star Super Seeker

Repairing Your Net

Your net won’t last forever. At the beginning of the
game, it’s good for 10 elf catches. After you catch the
first 10 elves, your net is worn out. The elves can jump
right through it! But don’t let that stop you — there’s

a solution. Find a net cave and repair your net. Each
time you repair it, your net will be good for 5 more

elf catches.

“When my net wears out and | don't have enough
coins to repair it, I'm not stuck. | can find more

coins along the path. | just walk over the coins to
pick them up.” — K. T., 2-Star Super Seeker




Repairing Your Net

To move the rock away from a
net cave:

m Stand in front of it and press
4 times to drop 4 coins.
(Mouse users can click in
the special instructions box
4 times.)

Net Cave Entrance

“| use my net a lot, so it wears out fast. And I'm
not always near a net cave. So | get my net

repaired whenever | can, even if it doesn’t need
it. |just make sure | don’t use up all my coins.”
— Sammy, 5-Star Super Seeker

To repair your net:
m Press to walk up to the open net cave. Next,

press (1], and then or (=] to continue
walking. (Mouse users can move in front of the
open net cave, click on the net cave, and then
click on the left or right of the path.)

“Did you ever catch two elves together? 1 did!

| like when this happens, because | get more
gold coins, and once | even got to answer two
puzzlers in a row. That was great, because |
got two clue words right away!” — Chris, 1-Star
Super Seeker

23




2 PLAYING THE GAME

TREASURE HUNTING

You have one purpose on Treasure Mountain — to find
treasures and get them to the castle! When you’re in
front of a place where a key or
treasure might be hidden, drop a
coin. Use the clue words you get
by answering puzzlers to help
you choose a likely hiding place.
Treasures are hidden in places
that match any 2 of the 3 clue
words. The key on each level is
hidden in the only place that matches all 3 clue words.

To drop a coin and find a treasure or key:

m Press [1]. (Mouse users can click in the special
instructions box.)

If an item is hidden where you drop a coin, it will be
yours. Treasures you find pile up in your treasure pack.
When you locate the key, the key outline in the Clue
Words box fills in.

The Clue Words box shows the clues you’ve found for
the level you’re on. The clue words disappear when
you climb to another mountain level. They’ll reappear
when you return to that level.

“| read clue words carefully. ‘Tree’ is different from
‘trees.” The clue word ‘tree’ matches a single tree.
But the clue word ‘trees’ matches two or more
trees.” — Ali, 2-Star Super Seeker




Climbing the Mountain

CLIMBING THE MOUNTAIN

After you find the key on each level, you can open the
lock. Then you can continue up the mountain.

To open a lock:

® Move in front of it and press . You’ll start
moving up. Hold down to continue moving
up. (Mouse users can stand in front of the lock,
click on it, then hold down the mouse button.)

To move back down a ladder:

m Press . Hold down u to continue. (Mouse
users can click on a lower part of the ladder, then
hold down the mouse button.)

Once you open a lock, it stays open. Then you can
easily move up or down the mountain. Don’t forget to
look for shortcuts that can take you from one side of the
mountain to the other.

“The clue word ‘tall’ can match something big,
like a big flower. The clue word ‘big’ can match
a tall thing, like a tall sign. The same goes for
the clue words ‘short’ and ‘small.” ‘Short’ can
match a small thing and ‘small’ can match a
short thing.” — Kim, 4-Star Super Seeker

25




2 PLAYING THE GAME

¢ The Giant Tree is an easy climb

up from level 1 to level 2. To

get to level 3, take a wild, wet

ride on Fish Fountain. But be .
careful at the top — the fountain’s

slippery sides can take you

" tumbling back down.

You’ll huff and puff, but you’ve made the grade when
you pass the Grate Gate into the Secret Stone Tunnel.
Here, you’ll need to climb the ladders and jump from
one to another to scramble up to the top. Watch out for
the Master of Mischief. Don’t let him push you off the
ladders and take your coins!




In the Castle

IN THE CASTLE

You’ve made it! You’re in the castle. And the Master
of Mischief is furious!

Watch as the treasure chest
opens and your treasures fly into
it. As areward, you win a prize!
It’s one of the treasures you just
collected.

To skip the parade of treasures
and hurry down to the clubhouse:

B Press .

Then you slide down the Super Chute (your prize goes
with you), back to the clubhouse. There, you can view
your prizes. And you get to start another hunt for
treasures.

27




2 PLAYING THE GAME

VIEWING YOUR PRIZES

Back at the clubhouse, you can look at all the prizes
you’ve collected. Your slide down the Super Chute
lands you in the clubhouse, standing by the prize
you’ve just won. Watch your prize carefully — it may
surprise you!

To see all your prizes:

m Press or to move

in front of the Prize buttons
on the right side of the
clubhouse door. Then press
to walk up to them.
The last prize you won is
on the shelf. Press -] or (<] to bring out your
other prizes.

To animate a prize:

m Press [T].

To walk away from the prize shelf:
m Press :

As you play game after game, the shelves in the other
rooms in the clubhouse fill up with prizes. To see

them, walk through the door marked PRIZES on the
right side of the clubhouse.




Going Up in Rank

GOING UP IN RANK

In the clubhouse, you can check on your rank by
looking at the rank screen.

To see the rank screen:

W Press or to move in front of the Treasure
Chest button on the left side of the clubhouse
door. Then press to walk up to it. The rank
screen appears. (Mouse users can move in front
of the button, then click on it.)

Watch the chest fill and your
points add up on the rank screen
as you play the game over and
over. You get 1 point for each
treasure you take to the castle.
Every time you get a star, your
rank increases. The chart on the
next page shows how many points (treasures) it takes
to earn each star.

To leave the rank screen:
m Press .

When you’re ready to play another game, walk out the
clubhouse door. You’ll start the new game with the
same number of nets and coins you had at the end of the
last game.

But something about the mountain will have changed.
There will be new places to look, new puzzlers to
answer, and perhaps more treasures to find!
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PLAYING THE GAME

WINNING THE CROWN

When you’ve filled the treasure chest and made it to the
rank of Champion, you’ll win back the crown from the
Master of Mischief. The chart shows what it takes to
become a Champion.

Rank Treasures Treasures
on Each in the Chest
Level (Points)
Trainee 7 0-4
1-Star ¥ 5-24
2-Star 3 25 -69
3-Star 3 70-114
4-Star 4 115-169
5-Star 4 170 — 229
6-Star 5 230 -299
Champion 3 300 and up

Once you become a Champion, you can still collect
5 treasures on each level and bring them to the castle.
Happy treasure hunting, Super Seeker!




Educational
Focus

UPER SEEKERS ADVENTURES ARE
CAREFULLY DESIGNED to engage the imagina-
tion and motivate learning. Valuable educational
material is woven into exciting game settings to
provide players with a richly rewarding experience.
The educational components of Treasure Mountain!
are covered in this chapter.

From the opening screens to the final ascent,
children see Treasure Mountain! as an immensely
enjoyable game. On closer inspection, parents and
teachers discover that as children play the game,
they also become immersed in a rich learning
experience. The information that follows is a
discussion of how Treasure Mountain! has been
designed to be both entertaining and instructive.
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3 EDUCATIONAL FOCUS

ENGAGEMENT FACTORS

The imaginative storybook setting of Treasure
Mountain! and its popular, age-appropriate themes
and characters draw players directly into an engaging
adventure. This direct involvement in the story pro-
vides an important opportunity for learning. In assum-
ing the role of the Super Seeker, the player acts out an
adventure that could otherwise only be imagined.

Exploration and discovery are important activities in
the world of Treasure Mountain! In playing the game,
the child explores a colorful, multi-screen environment,
interacting with characters in search of clues and gold
coins that lead to hidden treasures. There is no time
limit in the program and no end to the variety of paths
to follow in the course of a game. Curiosity and initia-
tive are rewarded, and children’s confidence and sense
of self-esteem grow as they learn to interact produc-
tively with the game environment.

The program uses familiar play patterns as the contexts
for educational content. Many of the activities are
reminiscent of classic children’s games such as king

of the mountain, hide and seek, tag, and treasure hunt.
The arcade action incorporated into various game
elements — Fish Fountain, the elf interactions, and the
Secret Stone Tunnel, for example — is indicative of how
the program utilizes the power of the computer to make
gameplay captivating and exciting. When children’s
interests are engaged in this way, their willingness to
learn is greatly enhanced.
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Curriculum Skills

CURRICULUM SKILLS

The educational components of the game are designed
to augment the most important subjects in the elemen-
tary school curriculum:

B [anguage arts, including reading comprehension,
phonetics, vocabulary, and word use;

B arithmetic, including problems that build fluency
with math facts and develop numerical reasoning;

B science, including exposure to interesting scientific
facts and principles, and the interrelatedness of
everything in the environment.

Rather than providing direct instruction, this learning
game requires children to apply the skills they are being
taught in school. To collect clues and coins that lead

to hidden treasures in the game, players must answer
carefully designed questions, called “puzzlers.” These
puzzlers grow more challenging as players demonstrate
proficiency in the targeted subjects.

The program repeats incorrectly answered puzzlers up
to three times within a given game, removing the incor-
rectly chosen item from the set of possible answers.

In this way, players can learn from their mistakes and
converge on the correct answer in subsequent attempts.
However, players who answer puzzlers on the first try
move more quickly to puzzlers at the next higher level.
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3 EDUCATIONAL FOCUS

Whether or not they move on to more difficult puzzlers,
players are able to move up in rank and enjoy more
challenging levels of game play. Conversely, players’
progress through the puzzler levels is not impeded by
any difficulty they may have with the game elements.

THINKING SKILLS

The development of thinking skills is essential to

a child’s academic success. Treasure Mountain! is
designed to help players increase their ability to think
logically and critically.

Gathering Information

Players decide when and how to interact with elves

in order to collect clues and magic coins. This activity
increases players' ability to notice and collect relevant
information by observing external events and recalling
information from memory.

Organizing Information

Players mentally organize clues to determine where
and how to apply them in the game. In this way, they
improve their ability to order and sort information for
appropriate retrieval.
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Thinking Skills

Analyzing Information

Players use analytical skills in addition to curriculum
knowledge to answer the questions posed by the elves’
puzzlers. The puzzlers increase players’ ability to
formulate questions about information, to recognize
relationships among parts, and to discriminate between
relevant and irrelevant points.

Inductive Reasoning

Players infer rules from the items in a clue set and ap-
ply these rules in various game situations. They also
use trial-and-error methods to determine the best ways
to approach obstacles that confront them in the game.
In these ways, players improve their ability to infer
general principles and rules, and to draw conclusions
from particular situations.

Deductive Reasoning

Players compare objects in the game against rules
inferred from a clue set to determine where keys to the
locks can be found. This is an example of how the
program develops players’ ability to weigh supporting
and conflicting evidence in verifying beliefs and
assumptions, and to apply general rules to specific
situations and logically predict outcomes.
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3 EDUCATIONAL FOCUS

Decision Making

Throughout the game, players analyze situations to de-
cide the best way to proceed when presented with alter-
native routes and competing goals. In so doing, they
increase their ability to consider alternative approaches
or actions, weighing the benefits and liabilities of each
before proceeding.




4

Appendixes

HE APPENDIXES IN THIS SECTION offer
you technical and special information about install-
ing, running, and using Treasure Mountain!

Appendixes A, B, and C explain how to easily set up
the program on your hard disk or with Tandy
DeskMate or with Microsoft Windows. Appendix D
1s a quick reference to special keys used in Treasure
Mountain! Appendix E offers solutions to common
problems when installing or using the program.
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4 APPENDIXES

APPENDIX A:
HARD DISK INSTALLATION

If you have a hard disk (fixed disk), it is best to run the pro-
gram from that hard disk. The installation procedure puts a
copy of Treasure Mountain! on your hard disk. This procedure
creates a special storage area, or directory, on your hard disk
called TLC (for The Learning Company) and another directory
within that one called TMT (for Treasure Mountain).

Before you continue, be sure you have made a backup copy of
the disk(s) using the DOS command DISKCOPY. (See your

DOS manual for instructions.)

To install the program on a hard disk:

1. When you see the C> prompt (or another DOS prompt that
identifies your hard disk), insert the program disk (Disk 2 if
you’re using 5.25" disks) in drive A.

2. Type A: and press [ Enter].
3. Type INSTALL and press again.

4. Follow the instructions on the screen.

To start the program from DOS once you have installed it
on your hard disk:

m At the C> prompt, type TMT and press :




B: Tandy DeskMate Installation

APPENDIX B:
TANDY DESKMATE INSTALLATION

Whether you choose to run Treasure Mountain! from your hard
disk or from the program disk(s) that came in the package, you
can customize the DeskMate desktop to make starting the pro-
gram quick and easy. By following the instructions below, you
can create a special application list box for Treasure Mountain!
This will allow you to start the program from the desktop just
by selecting TMT (for Treasure Mountain). If you plan to in-
stall the program on your hard disk, do so before customizing
the desktop.

To customize the DeskMate desktop:
1. Insert the Program Disk (Disk 1 if you’re using 5.25"
disks) into drive A.

2." Press to open the Desktop menu.

3. Highlight Install and press (] Enter].

4. When the Display menu appears with TMT highlighted,

press (] Enter).

S. Use the arrow keys to position the dotted box where you
want it to be. (This will be the application list box for

Treasure Mountain!) Then press to place it.

6. Press again.

7. Highlight Redefine and press . The Redefine
menu appears. If TMT is not already highlighted, high-
light it.

8. Press g

9. At the next Redefine menu, tab to the fourth box, called
Startup Directory.
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4 APPENDIXES

10. Then, if you will be running Treasure Mountain! from

m a floppy disk, type A:\ (or B:\) and press :
m your hard disk, type \TLC\TMT and then press

)

Now you can start Treasure Mountain! by selecting TMT in the
application list box.




C: Microsoft Windows Installation

APPENDIX C:
MICROSOFT WINDOWS
INSTALLATION

You can start Treasure Mountain! from DOS or from your
Windows desktop (if Windows is installed). Follow the in-
structions below to install Treasure Mountain on your hard
disk, set up a new program group on your Windows desktop,
and attach a new program icon to it.

To install Treasure Mountain! under Windows:
1. Type WIN to start Windows.

2. Insert either the Program Disk (3.5") or Disk 1 (5.25") into
disk drive.

3. At the Program Manager screen, choose Run... from the File
menu.

4. Type A:\INSTALL or B:\INSTALL (depending on whether
you inserted a disk in drive A or B) in the Command Line box.
Then click on OK.

5. Follow the instructions on the screen. After you read the
message about how to start TMT from DOS from your hard
disk, press . You will exit the install program and return
to Windows.

6. If you already have a TLC Program Group then you should
open it now and skip to step #9. If you do not have a TLC
Program Group, then, at the Program Manager screen, choose
New... from the File menu. The New Program Object dialog
box appears.

7. Click on Program Group to select it. Then click on OK. The
Program Group Properties dialog box appears.
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10.

11.

12.

13.

14.

15.

16.

In the Description box type TLC and click on OK. A TLC
window appears.

Choose New... from the File menu. The New Program
Object dialog box appears.

Click on Program tem to select it. Then click on OK. The
Program Item Properties dialog box appears.

In the Description box type Treasure Mountain! and press

:

In the Command Line: box type C:\TMT.BAT and then
click on Change Icon. (If Treasure Mountain! was installed
onto another drive, then substitute the letter of the appropri-
ate drive for C.)

A message box appears stating, ‘“There are no icons avail-
able for the specified file. You can choose an icon from
those available for Program Manager.” Click on OK.

In the File Name box type C:\TLC\TMT\TMT.ICO and
then click on OK. (If Treasure Mountain! was installed
onto another drive, then substitute the letter of the appropri-
ate drive for C.)

The Treasure Mountain icon appears in the Current Icon
box. Click on OK.

Click on OK in the Program Item Properties dialog box.

You now have a TLC program group on your Windows desk-
top and a Treasure Mountain! icon in the TLC group.
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C: Microsoft Windows Installation

To launch Treasure Mountain! from Windows:

®  Open the TLC group and double-click on the Treasure
Mountain! icon.

To launch Treasure Mountain! from DOS:
m Exit Windows and type TMT at the C> prompt.

TIPS FOR RUNNING UNDER_WINDOWS

1. Do not run multiple programs at one time while playing
Treasure Mountain!, especially in standard mode.

2. Completely exit Treasure Mountain! before returning to
Windows.

3. Do not run Treasure Mountain! in a window. It must
always be run full screen.

4. To run Treasure Mountain!, your computer must have at
least 464,000 bytes free before starting Windows.

5. Do not run Windows in Real Mode. Treasure Mountain!
will not run under Windows in Real Mode.

6. Turn off 32-bit virtual drive access in the control panel.
7. Do not press the Print Screen key.

If you have any questions, call our Technical Support
Department at 1-800-852-2255.
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APPENDIX D:
SPECIAL KEYS

MOVING AROUND THE MOUNTAIN

KEY ACTION

or Walk left or right. Hold the key down to
continue walking.

or Flip up to the left. Hold the keys down

to do a double flip.

or [PgUp|  Flip up to the right. Hold the keys down

to do a double flip.

Walk up to an open net cave; open locks;
enter a tunnel or cave; climb up. Hold
the key down to continue climbing up.

Drop a coin; climb down. Hold the key
down to continue climbing down.

Drop your net.

Turn the sound (and music) off or on.




D: Special Keys

ANSWERING PUZZLERS j
KEY ACTION
or Move the box to mark your answer.
Select your answer; return to the game.

USING THE MENU BAR

ACTION
Display the Help menu.
Display the File menu.

Display the Options menu.

DEEE 5

9
W

See other menus, when one menu is
already displayed; move the highlight
on information screens.

1] or Cycle through the menu items.

~ Enter Select a highlighted menu item.

(PgUp] or ([PgDn] Move backward or forward one page in
a Help choice.
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VIEWING PRIZES AND RANK SCREEN

ACTION

In the clubhouse, move up to Prize
buttons or Treasure Chest button. At
the Prize buttons, animate your prize.

At the Prize buttons, see other prizes.

Walk away from the Prize and Treasure
Chest buttons.

KEY
or

R

ACTION

Highlight a name or New Player on the
list.

Select a highlighted name; enter a name
you type.

Erase the last letter you typed when
entering a name.

Begin the process of permanently
erasing a name, rank, and total treasures
from the Club Sign-In list.




E: Troubleshooting

APPENDIX E:
TROUBLESHOOTING

The items in bold below are problems you might possi-
bly encounter when using Treasure Mountain!

The text below them contains possible solutions to the
problems. If you need more assistance or have any
questions, call our Technical Support Department at
1-800-852-2255.

INSTALLlNG THE PROG RAM

1. When you try to copy the program t0 your hard dlSk
you see the message “A hard disk is not available,” even
though you have one.

Make sure your hard disk is properly connected to your
computer. If your hard disk is a separate unit, make
sure it is turned on. If your hard disk doesn’t have
enough room for the program files, erase some files to
make room for the program on your hard disk. You
must have 800,000 bytes free.

If you started your computer with a DOS disk and have
a hard disk set up by a disk driver or disk manager, you
will need to start your computer from the hard disk.

2. When you’re using 5.25" disks and running the pro-
gram from a floppy drive, the computer doesn’t read
Disk 2.

Quit the program and return to DOS. Insert Disk 1 in
drive A, and Disk 2 in drive B. Then type TMT to
restart the program. (The problem occurs when you
have 2 floppy disk drives. Both disks must be inserted
in the drives in order to run the program.)
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USING THE PROGRAM

3. Yo e nthn ut blan cree hn yo load h 8
program.

This may happen on some machines when you turn the
monitor on after the computer.

°

Start over. Be sure to turn on the monitor
before you turn on the computer.

If you have two graphics adapter cards in your
computer, you must tell the computer which one
to use. When you start the program, type

TMT -C (for CGA), TMT -E (for EGA or
EGA mode on VGA), TMT -M (for MCGA),
or TMT -T (for TGA) instead of just TMT.
(Don'’t forget the space after TMT.)

4. The game action is very slow.

If you have an EGA monitor running on an IBM XT or
on any 8088 4.77 MHz Intel® machine, the game will
run slowly. The speed is limited by the rate at which
the computer can process the information displayed on
the screen. Computer performance can be upgraded by
adding an accelerator board.

5. When using the program, you get a message that the
disk is “write protected.”

You need to remove the write protection from the disk.

On a 3.5" disk, slide the tiny plastic tab down to
close the hole in the upper-right corner of the
disk.

On a 5.25" disk, remove the write-protect tab
(tape) from the notch in the upper-right corner
of the disk.




E: Troubleshooting

6. Music is not playing.

« Check that your speakers are properly connected to
your computer, getting power (have good batteries
or are plugged in), turned on, and that the volume is
turned up.

» Be sure that both the Music and Sound options are
set to YES.

« If checking the above items does not help, restart
the program by typing TMT -SA (for AdLib and
AdLib compatible boards, including Sound
Blaster), TMT -ST (for the Tandy 1000 series
sound chip), or TMT -SI (for IBM and compatible
speakers). (Don't forget the space after TMT.)

7. Your mouse doesn’t work.

A mouse driver program (described in your mouse
manual) must be correctly installed on the disk you use
to start the computer. If you start the computer using

+ ahard disk, make sure the mouse driver pro-
gram is correctly installed there. See your
mouse manual for instructions.

 a floppy disk, install the mouse driver program
in the root directory of that disk. See your
mouse manual for instructions.

+ If you use Windows, reload your mouse driver
from DOS.
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RUNNING UNDER WINDOWS

8. You see the message, “Unable to play sound—the
AdLib is in use by another application.”
Choose OK and then double-click on the Treasure
Mountain! icon. If the music is not coming out of your
AdLib card, quit Treasure Mountain! and close the
application that is using the AdLib card. Refer to your
Windows manual for more information.

9. You see the message, “Unable to use the AdLib device.
Device is either in use or is missing.”

Either the Adlib card is not installed or the AdLib
driver is not installed in the control panel.

o If there is an AdLib or Sound Blaster 1.0, 1.5,
or 2.0 card installed in your computer, install
the AdLib driver in the control panel.

e If you have a Sound Blaster Pro card, install the
Sound Blaster 1.5 driver in the control panel or
quit the application that is using the AdLib
device.

e If you have a Proaudio Spectrum™ 16 card or a
Proaudio Spectrum Plus card, install the AdLib
driver in the control panel or quit the applica-
tion using the AdLib device.

Refer to your Windows manual for more information.




E: Troubleshooting

10. The program starts and then quickly exits to Windows.

You may not have enough memory available to run
DOS applications through Windows.

Try quitting other applications before starting Treasure
Mountain! again.

There may not be enough base memory available to run
the program. Exit Windows and type chkdsk and press
. The bottom of the report shows the number
of bytes free. If you do not have at least 464,000 bytes
free, try removing device drivers in your config.sys and
autoexec.bat files. WARNING: Always make a backup
copy of your config.sys or autoexec.bat files before you
make changes. Refer to your Windows and DOS
manuals for more information.

Do not run Windows in Real Mode. Treasure
Mountain! will not run under Windows in Real Mode.

11. Your name on the sign-in list is missing or has addi-
tional letters; when you continue a saved game, it
doesn’t start at the level you were on; or your score is
incorrect.

Your saved game is corrupted or destroyed. Turn off
32-bit virtual drive access.
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12. You see the message, “You cannot run this application
while other high-resolution applications are running full
screen. The application will be suspended until a low-
resolution or text application is running full screen.
Check PIF settings to ensure they are correct.”

Do not run Treasure Mountain! in a window. It must
always be run full screen.

Click on OK. Press [Alt|and simultaneously

to change from windowed to full screen.

If you have any questions, call our Technical Support
Department at 1-800-852-2255.
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CUSTOMER SERVICE

We are proud of the special relationship we have with many satisfied parents and
teachers. If you have a problem, a question, or a suggestion, please call our
Customer Service Department at 1-800-852-2255 or 1-510-792-2101.

The Learning Company warrants to the original purchaser only that the disk
provided with this user’s guide and the software program coded on it will perform in
accordance with the descriptions in this user’s guide when used with the specified
equipment. If the program is found defective within 90 days of your purchase, it
will be replaced. Simply call The Learning Company’s Customer Service Depart-
ment at the above toll-free number and a replacement disk will be sent within 24
hours. Replacement of the disk is the full extent of our liability.

This warranty is in lieu of all other warranties, whether oral or written, expressed or
implied. Any implied warranties, including those of merchantability and fitness for
a particular purpose, are limited in duration to 90 days from the date of purchase of
this product.

The Learning Company shall not be liable for incidental and/or consequential
damages for the breach of any expressed or implied warranty including damage to
property and, to the extent permitted by law, damages for personal injury even if
The Learning Company has been advised of the possibility of such damages. Some
states do not allow the exclusion or limitation of incidental or consequential
damages or limitations on how long an implied warranty lasts, so the above
limitations or exclusion may not apply to you.

This warranty shall not be applicable to the extent that any provision of this
warranty is prohibited by any federal, state, or municipal law which cannot be pre-
empted. This warranty gives you specific legal rights and you may also have other
rights which vary from state to state.

Unauthorized reproduction, adaptation, distribution, performance, or display of this
document, the associated computer program, or the audiovisual work is strictly
prohibited.

Damaged Disk Replacement Policy: The Learning Company will replace disks
that the user damages for a duplicating and handling fee. Return your damaged disk
and a check for $10 to:

The Learning Company
8678 Thornton Avenue
Newark, CA 94560
Attention: Disk Return Dept.
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INDEX

A

accelerator board 48

adding your name 3-5, 46

AdLib and compatible sound

boards 49, 50

analyzing information 35

animating prizes 28, 46

answering puzzlers 14, 20-21, 45

arithmetic skills 33

arrow keys ([{],(T).(5.[=))
animating prizes 28, 46
answering puzzlers 21, 45
dropping coins 9, 17, 24, 44
flipping 17, 44

highlighting choices 4,5, 7, 45,

46
list of functions 44-46
moving around 11, 17, 25, 44
opening a lock 25, 44
opening a net cave 23
repairing a net 22, 23
seeing other menus 45
viewing prizes 28, 46
viewing rank screen 29, 46

B

backpack See treasure pack

Backspace key ([Backspace]) 4,
46

backup copy 2, 38

beginning the game (See also
starting the game) 6, 11

blank screen 48

board, sound See sound boards

butterfly See Flutter the Butterfly

button
on mouse See mouse button
Prize 28, 46
Treasure Chest 29, 46

C
card, graphics adapter 48
castle 15, 24,27
treasure parade 27
cave, net See net cave
caves and tunnels 18, 19, 44
CGA 48
Champion rank 15, 30
chart, rank and score 30
climbing See Giant Tree, mountain
level, and ladders
Club Sign-In screen
adding a name to 3, 4-5, 46
removing a name from 5, 46
signing in at 4-5, 46
Club, Super Seekers (See also
Super Seekers)
list of players 4
rules 14-15
signing in 1,3, 4,5, 46
clubhouse 6, 11, 14, 27, 46
exploring 28
viewing your prizes 14, 27, 28,
46
viewing the rank screen 14, 29,
46
clue words
earning 10, 16, 20, 21, 23
shown in Clue Words box 6,
10, 21, 24
special rules 21, 24, 25
using 10, 14, 16, 24, 25
Clue Words box 6, 10, 21, 24
clues See clue words




INDEX

coin sack 9
coins
dropping 9, 16, 17, 18, 19, 23,
24, 44
earning 9, 11, 15, 16, 20, 21, 22,
23
finding 22
left over 16, 29
losing 9, 15, 22, 26
shown in status box 9, 16
using 9, 14, 16, 23, 24, 44
collecting treasures 10, 13, 14, 15,
16,21,24
color monitor See graphics adapter
card
Control key ([Ctrl]) 44, 46
copy, backup 2, 38
copying the program to a hard disk
2, 38,47 See also Installing
crown
taken by the Master of Mischief
13
winning the 14, 15, 16, 30
curriculum skills of program
arithmetic 33
language arts 33
science 33
cursor See mouse
customer service 53
customizing Tandy DeskMate
39-40

D

decision making 36
deductive reasoning 35
defective disks 53
DeskMate, Tandy 2, 39-40
dialog box See message box

diamonds, treasure 10
directory 38,49
disk
backup copy 2, 38
floppy 2, 3, 38, 39, 40, 47, 48,
49
hard (fixed) 2, 38, 39, 40, 47, 49
problems with 47
Disk 1 3,47
Disk 2 3, 38,47
disk drive 2, 3, 38, 39, 40, 47
Disk Operating System See DOS
dodging (flipping over) elf dust 17,
22,44
Done 7
DOS 2, 3, 38,47, 49
drives, disk See disk drives

E
earning
clue words 10, 16, 20, 21
coins+9, 115:15, 16, 20,21::22;
23
points 14, 29
prizes 15,27
stars 15, 29
educational focus 31-36
EGA 48
elf catches per net 22
elf dust 15, 17,22, 44
elves 14, 15
catching 9, 11, 15, 16, 20-21, 22
earning clue words from 10, 16,
20-21
sprinkling elf dust 15, 22
with scrolls 20-21
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Enter key ( )
continuing 7,9
entering names of players 4, 46
running (starting) the program
253
selecting highlighted choices 5,
7,21,45,46
signing in 4, 5, 46
skipping the treasure parade 27
entering
answers to puzzlers 21, 45
caves and tunnels 18, 19
names of players 4, 5, 46
erasing
mistakes 4, 46
players’ names, ranks, and
scores 5, 46
error message 47, 48, 50
Escape key ( [Esc]) 7
Exit and Save 8
exiting the program 8
exploring
caves and tunnels 18, 19, 22, 44
the clubhouse 6, 28
the mountain 11, 14, 15,17, 19,
25, 26, 44

F
Fl key ([F1)) 7,45
F2 key ([F2)) 7,8,45
F3key ([F3)) 6.7.8.45
F7 key ([F7)) 39
File menu 8
filling the treasure chest 15, 16, 27,
29, 30
finding
coins 22
keys 10, 13, 14, 15, 16, 21, 25
treasures 10, 13-16, 21, 24

Fish Fountain 13, 18, 19, 26
5.25" disk 3, 38,47, 48
fixed disk See hard disk
flipping 17, 18, 19, 22, 44
over elf dust 17, 22, 44
over gaps in the path 17, 44
floppy disk (See also disk)
write protection 48
Flutter the Butterfly 6, 8
as the mouse cursor 18, 19
hints (messages) from 6, 8, 21
function keys (See also F1, F2, F3
and F7 keys) 6-8, 45

G
game
beginning 6, 11
playing 6,7, 14-26
saving 8
starting 7, 8, 11, 29
starting over 7, 8
winning 30
game plan 15, 16
game screen 6
information 6-11
moving around on 17-19, 44
gaps in the path 13, 17
gathering information 34
getting started 1-10
Giant Tree 26
Go Back a Page 7
graphics adapter card 48
Grate Gate 26
guide See Flutter the Butterfly
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H
hard disk 2, 38, 39, 40, 47, 49
installing the program on 2, 38,
problems with 47
help (See also New Player Hints)
getting 6,7, 8
Help menu 7
hiding places 14, 16, 21, 24, 25
highlighting
choices (items) 7,9, 45
names of players 4, 5, 46
puzzler answers 21, 45
hints (See also New Player Hints)
from club members 17, 19, 21,
22,23,24,25
Home key ([Home)) 44
hunting (searching)
for keys 11,24
for treasures 11, 21, 24, 25
I
IBM and compatible speakers 49
IBM XT 48
increasing your rank 15, 29
inductive reasoning 35
INSTALL command 38
installing
Microsoft Windows 41-43
problems 47
Tandy DeskMate 39-40
the program on a hard disk 2,
38,47
items, menu See menu choices

J

jumping (See also flipping)
from ladder to ladder 17, 19, 26
over gaps in the path 17

K

keyboard
playing the game 17-18, 20, 21,

23, 24, 25, 28, 44-45

selecting menu items 7, 45

keys (keyboard)
list of 44-46

keys (on the mountain) 14
finding 10, 13, 14, 15, 16, 21
in the Clue Words box 10, 24
searching (hunting) for 11, 24
using 16, 25, 44

L
ladders
climbing 17-19, 25, 26
jumping between 17, 19, 26
language arts skills 33
learning objectives of program 33
leaving (exiting)
the program 7, 8
the rank screen 29
left, moving 17, 18, 19, 44
level, mountain See mountain level
list of
club members 4, 5
keys for keyboard use 44-46
loading the program 2, 3
locks 10
opening (unlocking) 16, 18, 19,
25
losing coins 9, 15, 22, 26

M
Master of Mischief 4, 13, 26, 27, 30
MCGA 48
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INDEX

members, club
listof 4,5
number of 5
ranks 4, 30
membership, club See Super
Seekers
menu bar 6-9, 45
using 7-9, 45
menu choices (items) 7-9, 45
menus 7-9
viewing 7
message S, 8, 47, 48, 50
messages
from Flutter the Butterfly 6, 8
in the special instructions box 9
Microsoft Windows See Windows,
Microsoft
monitor 2, 48
Morty Maxwell See Master of
Mischief
mountain level 14, 16, 25, 26
climbing from one to the other
17-19, 24-26, 44
clue words on 14
key on each 16, 24, 25
treasures on 10, 16
mouse
playing the game 18-19, 21, 23,
24, 25,29
problems with 49
selecting menu items 7, 9
mouse button 9, 18, 19, 21
mouse cursor 18
as Flutter the Butterfly 18, 19

moving
around the mountain 11, 17-19,
R
down 17,44
in Help topics 7, 45
in the clubhouse 11, 28-29, 46
left and right 11, 17, 18, 44
up 18, 19,44
up in rank 29
with the keyboard 17-18, 23,
25,28, 29, 44-45
with the mouse 18-19, 23, 25
music 8
problems with 49, 50
saving your setting 8
turning on and off 8

N
names of players
adding 4, 46
removing 5, 46
net
catching elves 9, 16, 20-21, 22
dropping 18, 19, 44
left over 16, 29
number of elf catches per 22
repairing 9, 14, 16, 18, 22-23
shown in status box 9, 16
wearing out 9, 16, 22
net cave 16, 18, 22
opening 23
walking up to 18, 19, 44
new player, starting 4, 8
New Player Hints 6, 8
No 8




INDEX

O
opening

anet cave 23

locks 16, 18, 19, 25, 44
Options menu 6, 8
organizing information 34

P
pack, treasure 10, 16, 24
Page Down key ( ) 45
Page Up key ([PgUp|) 44, 45
pages in Help topics 7
path (trail), mountain 6, 10, 13, 14,
17518,:19,:20, 22
play area 6, 11, 18
players’ names
adding 4, 46
removing 5, 46
playing the game 6, 7, 13-30, 44,
45
points 8, 14, 29, 30
Prize button 28, 46
prizes
animating 28, 46
viewing 14, 28, 46
winning (earning) 15, 27
Proaudio Spectrum sound board 50
problems See Troubleshooting
program
disk 2-3, 38, 39,47, 48
exiting 7,8
installing 2, 38, 41-43, 47
problems 47-52
starting 2-3
prompt
DOS 3, 38
puzzlers 14, 16, 20, 21, 45
number of coins earned 21

Q
questions See puzzlers
quitting (exiting) the program 7, 8

R
Rkey ([R]) 46
rank 5,8
chart 30
increasing your 15,29
screen 14,29
viewing 14, 29, 46
reasoning
deductive 35
inductive 35
rectangle 21
Remove Player Name screen 5
removing players’ names, ranks,
and scores 5, 46
repairing your net 9, 14, 16, 18,
22-23
restarting a game 7, 8
Return key ( ) See Enter
key
right, moving 17, 18, 19, 44
rules
club 14-15
treasure hunt 21, 24, 25
running out of coins 22
running the program
from a hard disk 2, 38
from a floppy disk 2-3
from Microsoft Windows 41-43
from Tandy Deskmate 40

o8




S
Skey ((S]) 44
saving
agame 8
ranks and scores 8
science skills 33
score 5,8
viewing 14, 29, 46
scoring points 29
scrolls 20
searching
for keys 11,24
for treasures 11, 24
the mountain 11, 14-15
Secret Stone Tunnel 17, 19, 26
selecting
menu choices (items) 7,9
names of players 5, 46
puzzler answers 21, 45
with the keyboard 7, 45, 46
with the mouse 7,9, 18
service, customer 53
shortcuts 19, 25
signing in 4-5, 46
skills, curriculum See curriculum
skills of program
slide See Super Chute
solving puzzlers 16, 21
somersaulting See flipping
sound 8
problems with 49, 50
saving your setting 8
turning on and off 8, 44
Sound Blaster sound board 49, 50
sound boards 49, 50
sound chip, Tandy 1000 series 49

Spacebar key ([Spacebar]) 18, 19,

20, 44

speakers 49
special instructions box 6, 9
using 19, 23
special keys 44-46
speed of game play
problems 48
square 21
stars
earning 15, 29
starting
a game over 7,8
anew game 7, 8, 16, 29
a new player 4, 8, 46
the program 2-3, 41, 43
status box 9, 14, 16
Coins section 9, 20
Net section 9
screen position 6
Treasure section 9, 10
storage area See directory
story screens 3
subdirectory See directory
Super Chute 27, 28
Super Seekers
hints from 17, 19, 21,
22,23,24,25
signing in as a member 3, 4, 46

T

Tandy 1000 series sound chip 49

Tandy DeskMate 2, 39-40

TGA 48

thinking skills 34

3.5" disk 48

tips See help, hints, messages, and
and Windows, Microsoft

title screen 3

TLC directory 38
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TMT command 3, 38, 39, 40, 47,
48
TMT directory 38
trail See path
treasures 9, 10, 13, 27, 30
finding (collecting) 10, 13, 14,
15, 16,21, 24
hunting for 11, 24
points per 30
shown in status box 10
treasure chest 15, 16, 27
Treasure Chest button 29, 46
treasure diamonds 10
treasure hunt, special rules for
singular/plural 24
size 25
square/rectangle 21
Treasure Mountain 6, 13, 14, 20, 24
Treasure Mountain! See program
treasure pack 10, 16, 24
treasure parade 27
skipping 27
troubleshooting 47-52
tunnels and caves 18, 19, 22
typing See entering

U

unloading treasures 16, 27

unlocking (opening) locks 16, 18,
19,25

v
VGA 48

viewing

prizes 14, 28
rank screen 14, 29

W
walking 17, 18, 22, 44, 46
warning message 5
warranty 53
wearing out your net 9, 16, 22
Windows, Microsoft
installing under 41-43
problems with 49-51
starting from 43
tips for running under 43
winning
prizes 15,27
the crown 14, 15, 16
the game 30
write protection 48

.
Yes 5,8
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THE LEARNING COMPANY

Since 1980, The Learning Company has consistently produced the
highest quality educational software available. Our award-
winning products help develop your child’s underlying thinking
skills and creativity, while reinforcing important areas of the basic
curriculum, such as reading, writing, and mathematics.

Every program from The Learning Company undergoes extensive
research and testing, with input from educational professionals,
parents, and children. Each product features a precise balance of
educational content and entertainment value. So, your child
actually has fun while learning!

How do we do it? Enchanting characters. Challenging situations.
Rich game environments. State-of-the-art graphics and sound.
Progressive skill levels and game segments that can be customized
to meet your child’s individual needs.

As parents and educators, we recognize that education is a
continuous process. So we developed The Learning System.
Carefully sequenced by age groups, this system serves as a product-
selection guide—making it easy for you to confidently choose the
right products for your children at each stage of their educational
development. As an integral part of The Learning System, each of
our products addresses a specific age group and subject area with
appropriate themes to heighten your child’s interest in learning.

Ages3to6 Ages 6to 8 Ages 8to 10 Ages 10 & Up

Reader Rabbit's - Super Solvers Time Riders
Ready for Letters Reader R?bb" 2 Midnight Rescue! in American History
Pre-Reading Reading Reading History

Super Sol
Reader Rabbit 1 Treasure Mountain! s;;’f,’b;ﬁ,’;, Ancient Empires

Early Reading Reading Spelling Problem Solving

Super Solvers

Math Rabbit Treasure MathStorm! OutNumbered! Operation Neptune
Math Math Math Math

e The Children’s 4o
MetroGnomes’ Music Treasure Cove! Writing & Publishing Center | The Writing Center

Thinking/Creativity Science Writing/Publishing Writing/Publishing
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